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INTRODUCTION 
 

 
These guidelines reflect APA style as closely as possible and were developed with the 
consultation of a CLU advisory committee and two external manuscript editors. The 
goal of this document is to help you with final formatting of your dissertation and to 
create consistency among all cohort dissertations. Please share these guidelines with 
your manuscript editor. It is anticipated that changes will be minor.  Sample pages 
modeling the format are included. 
 

General Requirements 

 
Paper 
 

• Paper must be at least 20 pound, 25% cotton, bond.  
• Recommended: Southworth Fine Business Paper, 25% cotton, 20 pound, 

white, stock #403C  (Available for purchase through Office Depot, 
Officemax, Staples) 

 
Typeface 
 
Size 
 

• Font size for basic manuscript text should be 12-point. 
 
Font 
 

• Times New Roman in 12-point is a standard type and size. 
 

• Make one space at the end of a sentence and one space after a colon. 
 
Spacing 

• Add 1 space at the end of each sentence and after a colon
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Manuscript Formatting 

 
• Top Margin:  1” 

• Each new section--dedication page, table of contents, list of figures, list of 
tables, list of figures, list of symbols, acknowledgements, vita, abstract, 
chapters, notes, references, appendix, etc.--should have a 2” top margin.  
Depending on the word processing program you are using, the top margin 
may end up 1.9” or 2.1”.  This is acceptable, as long as top margins for 
sections are consistent throughout the document. 

•   Left margin:  1.5” (must be wide for binding requirements). 

•   Right margin:  1”  (left justification for a ragged right margin) 

• Bottom margin:  1” (page numbers should sit at the 1”, text will then sit 
approximately 1.25’ to 1.5” from bottom of page depending on the word 
processing program you are using). 

• Set Widow/Orphans control. A widow is the last line of a paragraph 
printed by itself at the top of a page. An orphan is the first line of a 
paragraph printed by itself at the bottom of a page. 

On the Format menu, click Paragraph, and then click the Line and Page    
Breaks tab. Select the Widow/Orphan control check box.   

Pagination 

 
Number all pages except for the title page following these guidelines: 
 

• Lower case Roman numerals are used for the preliminary pages (beginning 
with the signature page (iii) through last abstract page). The preference is for 
these to appear at the bottom of the page, centered. This may require creating 
a separate section for these pages. 

 
• Arabic Numerals are used following the abstract for the remainder of the 

dissertation.  
 

• These page numbers should appear at the bottom and centered of each page. 
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• The title page and copyright page should be unpaginated. 

 
Note: Your manuscript editor will know how to create the sections. If you are typing 
the document on your own, this pagination task may be difficult and you can choose 
to place the Roman numerals at the bottom of the page. (See the section on creating a 
section break.) 
 
 

Title Page Organization 

 
• Institution Name: CALIFORNIA LUTHERAN UNIVERSITY (All caps)  

 
• The name starts 2” from the top of the page. 

 
Dissertation Title: Title should appear with initial caps. The title is to be 14 
point. Example: 
 

CALIFORNIA LUTHERAN UNIVERSITY 
 
 
 

Advancing Educators: Master Teachers Renewing Practices 
at a Professional Development School 

 
 
 
 
APA style recommends initial cap for all words of four letters or more. 
(Prepositions and articles are not capped. See APA Manual, Section 3.13 p. 
95, 5th edition.) 

 
• A long title should be “stacked” as an inverted pyramid with close to equal 

lines: 
 

A Comparison of Graduates’ and Principals’ Perceptions of California 
Teachers Prepared Through Alternate and Traditional Certification 
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• Statement: A dissertation submitted in partial satisfaction of the requirements 
for the degree Doctor of Education in Educational Leadership  

 
• Department:  School of Education  

 
• Candidate: Name  

 
• Date: Should be date you receive your degree not when you completed the 

dissertation, e.g. May 2010  
 

• A word about titles: Create a crisp, descriptive title. Avoid lengthy and 
detailed titles and avoid titles that simply repeat your research question  
 
 
 

Order/Appearance of Front Pages 
 

1. Title page (Counted but not numbered) 
2. Copyright page or blank page. The copyright notice should be placed near the 

center of the page 
3. Signature page  (Follow sample) 
4. Dedication page (Optional)  
5. Table of contents (Follow sample) 
6. List of figures, list of tables, list of symbols (Containing page numbers) 

(Follow sample) 
7. Vita (Optional) 
8. Acknowledgements (Optional)  
9. Abstract (Final item with Roman numerals)  

 

Signature Page  

 
• List committee members only in alphabetical order, listing highest degree of 

each committee member.  These should be single-spaced. 
• The last signature should be the committee chair 
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Graduate Studies 
 

at 
 

California Lutheran University 
 

Upon the recommendation of the dissertation committee, 
this dissertation by Gayle I. Pinkston is hereby accepted in 

partial fulfillment of the requirements for the degree of 
 

Doctor of Education 
 
 
 
 
 
 
_________________________________ 
Deborah E. Erickson, Ed.D. 
 
 
 
_________________________________ 
Rita Wolenik, Ed.D. 
 
 
 
_________________________________ 
James R. Valadez, Ph.D. 
Committee Chair 
 

 
__________________ 

Date 
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Abstract 

 
The abstract is a brief descriptive summary of the dissertation. It should include a 
definitive statement of the problem, a brief description of the research method and 
design, major findings and their significance or lack there of, and conclusions. The 
abstract must carry a title page.  
 

• The abstract should be double-spaced and limited to 350 words. Top margin 
should be 2”  

• The title should be in all caps and read ABSTRACT OF THE 
DISSERTATION  with the title of the dissertation directly below, single-
spaced: 

 



 9

ABSTRACT OF THE DISSERTATION 
 
 

Advancing Educators: Master Teachers Renewing Practices 
at a Professional Development School 

 
 

by 
 
 

Gayle I. Pinkston 
 

Doctor of Education in Educational Leadership 
School of Education 

California Lutheran University, 2006 
Dr. James R. Valadez, Chair 

 
This qualitative study followed a grounded theory design inquiring into school 

renewal at Benjamin Professional Development School (PDS). The participants were 

the master teachers, and the data sources included historical documents and a field 

notebook. Multiple collection methods were used, including a questionnaire, 

interviews, and observations. The author used a constant comparison analysis to 

develop an emerging theory, and triangulated the findings. The procedures of open 

coding, axial coding, and selective coding found themes and patterns grounded in the 

data, and member checking validated the information. The author found that the 

phenomenon of a heightened awareness influencing master teachers to make changes 

in educational practices proved beneficial. The author proposes a theoretical model of 

school renewal illustrating this process and recommends further studies and sharing 

findings for a greater understanding of professional development schools.  
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Sample Vitas 

Example #1  

 

VITA 
 

Michele Rose Sanford-Dean 
 
ADDRESS:  2501 Topaz Court 
   Oxnard, California 93030 
 
EDUCATION: Ed.D.  2006  California Lutheran University 
                         Educational Leadership 
 
   M.A. 1989  California Lutheran University 
                                                           Educational Administration/Bilingual Education 
 
   B.A. 1978  California Lutheran University 
                          Liberal Arts/Spanish 
 
PROFESSIONAL EXPERIENCE: 
 
2003-Present  Principal, Montalvo School, Ventura Unified School District 
 
1999-2003  Manager, Professional Development Curriculum, Assessment 
and 
   Instructional Services, Oxnard Elementary School District 
 
1998-1999  Assistant Principal, Ocean View Junior High School, Ocean 
View 
   School District 
 
1979-1998  Bilingual Teacher, Mar Vista Elementary School, Ocean View 
   School District 
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Example #2  

VITA 
 
 

Sheila Harmon graduated with a bachelor of science degree in education from Ohio 

University in 1973. She received a master’s in education from California Lutheran in 

1984. In 2002, she obtained a master’s in clinical psychology with an emphasis in 

marriage and family therapy and is a California State licensed marriage and family 

therapist (LMFT) certified in infant, toddler, and family mental health. As a therapist, 

she has worked with many childhood difficulties, including adjustment problems, 

autism, medical illness, and adoption (international and domestic). She is also 

credentialed by the State of California to teach the following programs: preschool, 

kindergarten, Grades 1 through 12, adult classes, severely handicapped, physically 

handicapped, learning handicapped, and resource specialist. Over a 30-year span, she 

has worked as an educator teaching a wide variety of children from infancy to middle 

school. Her teaching experiences include both conventional and special education 

classrooms. These experiences as a teacher and a therapist have integrated to create a 

perspective that incorporates both educational and psychological viewpoints. Her 

theoretical orientation can be described as developmental and relationship-based 

psychotherapy. 
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Table of Contents/List of Tables/List of Figures format 

 
• Table of Contents / List of Tables / List of Figures (Initial caps)  

 
• Top margin 2”  

 
• TABLE OF CONTENTS heading 12 pt. Roman all caps  

 
• Use dot leaders to flush right page number 

 
• Words “TABLE OF CONTENTS” (etc.) should be 5” from top of page  

 
Chapter titles 

 
Chapter titles in text should begin 5” from top of page. Chapters and titles 
should be in all caps: 

CHAPTER 1 

INTRODUCTION 

Overview of the Problem 

Despite the rapid growth of professional development schools (PDSs) and the 

increased abundance of information about them, a need continues for more rigorous 

research. Strong evidence supporting their benefits is critical to warrant further 

development and implementation. Teitel (2000) believed PDSs would wither away 

without substantial documentation. 
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APA Heading Levels  

 
• CLU has adopted the three levels format of APA as describe on pages 114-

115 of the APA style manual. Level 5 is required for Chapter headings: 
 

Chapter titles are Level 5 (CENTERED UPPER CASE HEADING) 
 
 

 CHAPTER 2   
 

Level 5 
 REVIEW OF THE LITERATURE     

 
 

 
 
 

 
 
Here is an example of how to apply Levels 5, 1 & 3: 

Level 5 
 CHAPTER 3 
 
 METHODOLOGY  
 
         Samples and Procedures       Level 1   
 
Population    Level 3 

 
 
• See APA manual, Section 3.31, pages 113-115 for additional examples of 

headings. See also pp. 289- 290 of APA manual for further discussions on 
headings. 
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Here is how Levels 1, 3 & 4 will appear as described on pages 114-115 of APA: 
 
 

 Method Level 1 
 
Apparatus and Procedure  Level 3 
 
 

Pretraining period.  Text of paragraph follows.                      Level 4 
 

 

 

See Appendix A for additional information
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Quotations 

 
• Short quotes: Quotations of fewer than 40 words should be incorporated into 

text and enclosed by double quotation marks. See APA manual, p. 292. 
 

• Long quotes:  Block quotes of 40 or more words should be displayed in single 
space with double space before and after. Example: 

 
The challenge of qualitative analysis lies in making sense of massive amounts 
of data. This involves reducing the volume of raw information, sifting trivia 
from significance, identifying significant patterns, and constructing a 
framework for communicating the essence of what the data reveal. (p. 432) 
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Tables 

 
Spacing in tables 

 
• Single space text.    
• Tables should be embedded in the text of the manuscript and placed as 

aesthetically as possible after they are first mentioned. 
• Tables are numbered in the order in which they are discussed.   
• Tables should not be split between pages unless a table in itself is more than 

one page long.       
• Each table should be labeled e.g.: 
 
Table 2.1 
Table 2.2 

 
• Table 2.1 is the first table in Chapter 2; Table 2.2 is the second table in 

Chapter 2, and so on. The same would be true for numbering figures, boxes, 
charts, maps, and the like. 

 
Example of a table: 
 

Table 4.1 
T-test (2-tailed) Results for Freshman Seminar Class (N = 13) 

 Paired differences 

t df Sig. 
(2-tailed)

 
M SD Std. error 

mean 

95% confidence 
interval of the 

difference 

Pair 1 
Pretest-
posttest 

-1.38462 2.22817 0.61798 -2.73109 -0.03815 -2.241 12 0.045 
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References Page 

 
• Top margin of the first page of the references should be 2.” All other 

reference pages are 1” top margin.  
• REFERENCES precedes list of references. References should begin on same 

page.  
 

References and Appendices 

 
• References should appear first.   

 
• References should appear single spaced, with double between. Example: 

 
REFERENCES 

 
 
Andretta, S. (2005). Information literacy: A practitioner’s guide. Oxford, England: 

Chandos Publishing. 
 
Aspin, D. N., & Chapman, J. D. (2000). Lifelong learning: Concepts and conceptions. 

International Journal of Lifelong Education, 19(1) 2-19. 
 
Association of American Colleges and Universities (AACU). (2002). Greater 

expectations: A new vision for learning as a nation goes to college national 
panel report. Washington, DC: Author. 

 
 

• Appendices follow references.  
 

• The format should be: Appendix A, Appendix B, Appendix C.  Note:  
Appendix items are lettered in the body of the document and placed in the 
Appendices in the order in which they are mentioned.   
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Footnotes and Endnotes 

 
Footnotes and Endnotes credit the sources of referenced or paraphrased material. 
These refer readers to exact pages of works listed in the References section. 
 

• Footnotes are placed numerically at the foot of the very same page where 
direct references are made. 

 
• Endnotes are placed numerically at the end of the chapter on a separate page 

entitled Endnotes or Notes. 
 
To add a footnote, with your cursor blinking where you want to add the superscript, 
click on the Insert menu, then click on Reference and then on Footnote. In the box 
that appears, choose Footnotes and use the pull-down menus (if necessary) to choose 
Bottom of page, correct number formatting (1, 2, 3 . . .), and Continuous. Click on 
Insert. A superscript number will appear at the bottom of the page where you can 
enter the footnote text. 
 

Section Breaks 
 
To add a section break: On the Insert menu, choose Break, and in the box that 
appears, find "Section break types" and choose "Next page." 
  
For more help on working in Word, there are a number of free tutorials on the 
Internet. Search for "free Word tutorials" using your favorite search engine (e.g., 
Google.com, Yahoo.com, dogpile.com). 
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A Word about Copyright 

 
What is copyright? 
 
Copyright protects the published and unpublished works of authors of literary, 
dramatic, musical, artistic, and certain other intellectual forms of expression such as 
digital works. Copyright aims to foster the creation of all forms of intellectual 
property or works of authorship by providing fair returns to creators and copyright 
owners and to curb unauthorized and uncompensated copying (Association of 
American Publishers, 2006). 
 
Copyright: 
 

• Protects the published and unpublished works of authors  
• Allow quoting a source and citing source 
• Forbids “stealing“ others’ words and ideas 

 
Avoid copyright problems by: 

• Citing every source you use 
 

• Paraphrasing  
 
 

Always seek the publisher’s permission when you plan to use: 
 

• Charts, figures, tables from published or unpublished works 
 

• A test or instrument 
 

• Graphics, images, content from a Web site 
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Writing to Avoid Plagiarism 

 
Paraphrase often and cite you every source you use to avoid plagiarism 
 
Paraphrasing means restating or rewriting an author’s words into your own words 
without altering the original meaning or ideas conveyed by the author. 
 
Guidelines for effective paraphrasing 
 

• Read and reread the passage 
• Outline using own words and phrases 
• Write the passage  
• Use different words, synonyms, new phrases 
• Create a different sentence structure  
• Use different arrangement of points and ideas 
• Compare original with paraphrase 
• Cite the source 

 
Common Paraphrasing Errors 
 

• Changing few words 
• Keeping same sentence structure 
• Adding own ideas/explanations 
• Evaluating, judging, interpreting 
• Exaggerating, misrepresenting source 
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Final Copies 

 
After your final draft has been approved you are then ready to print the final copies 
on 25% cotton bond paper. These are to be professionally bound. You are required to 
provide three copies: 
 
1 for the School of Education 
1 to your committee chair 
1 to the Pearson library 
 
In addition, please provide the Pearson Library with an electronic copy which will be 
added to CLU digital archives called Metacat. The electronic version will also be sent 
to University Microfilm International (UMI) for inclusion in a searchable database of 
dissertations. Your electronic document can be in Word format or PDF format. Please 
send your final electronic copy to Henri Mondschein at mondsche@clunet.edu 
 

Submitting Your Dissertation to ProQuest CSA 
 
Your final version which includes the signatures must be submitted electronically to 
ProQuest CSA. This will enable your dissertation to be listed in the Dissertation 
Abstracts database and if you choose, made available in full-text to researchers 
worldwide. You will need to scan your signature page and add it to the final PDF 
version. If you will use the Conejo Unified School District printers, Kinkos or another 
service, they can help you with scanning the signature page and creating the final 
PDF document. You will have options for releasing your dissertation as “open 
access” or “traditional publishing.”  
 
You will need to make a credit card payment to ProQuest for processing the 
manuscript and for copyright fees. ProQuest charges a standard fee of $55 for the 
archiving of the dissertation, and UMI Dissertation Publishing charges $65 to file for 
copyright on your behalf. 
 
Follow this link for complete information: http://dissertations.umi.com/callutheran/ 
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APPENDIX A 

 
 
 

APA HEADING LEVELS 
(level 5, centered, all caps) 

 
By Lisa Elliott 

Dissertation Editor 
 

Common Headings and How to Format Them 
(level 1, initial caps only, centered) 

 
 
Level 3 
 Flush right, italics, drop down to the next line and indent.  Most APA papers 
(according to the APA Publication Manual) use only levels 5, 1 and 3.  However, I’ve 
seen a number that also use heading level 4. 
 Level 4. Indented, italics, followed by a period. The text of your paper will 
follow directly after that period. Level 4 is never included in the table of contents 
(TOC).  Table of contents only includes levels 1 and 3. 
 

Important Points 
 

Every heading must have a counterpart within the same section.  This means: 
• If you use a level 1 heading within a chapter, you must use at least one 

more level one heading within that chapter. 
 

• If you use a level 3 heading, you must use at least one more level 3 
heading before you move on to another level one heading. 

 
• If you use a level 4 heading, you must use at least one more level 4 

heading before you can move on to another level 3 or level 1 heading. 
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Here is an example of an outline for a paper on Portuguese Water Dogs. Please note, 
this is not a TOC (table of contents). It is an outline only.  A TOC would not show the 
level 4 headings.   
 
Level 5 
Level 1 
Level 3 
Level 4 

PORTUGUESE WATER DOGS (Level 5) 
 
CHAPTER 1     History of the Portuguese Water Dog (Level 1) 
 Portuguese Water Dogs at work (Level 3) 
 The Rise of Commercial Fishing (Level 3) 
       Decline in popularity (Level 4) 
       Rare Breed Status (Level 4) 
 A Movement to Restore the Breed (Level 3) 
 
Notice, there are 3 level 1 headings (headings in green) following the level one 
heading (chapter heading in blue). APA requires that you use at least 2 IF you use any 
at all.  But there is not upper limit on how many you can use.   
 
You will also notice that there are no level 4 headings (orange) following the first 
level 3 heading.  This is okay.  You are NOT required to use any at all.  But if you use 
one, then you must use at least 2. 
 
 
2.  The second issue that I see with headings is an overuse of levels 3 and 4.  APA 
does not have specific guidelines on this, but remember, if you break your paper into 
sections that are too many and too short, it can lose some integrity.  The strength of 
your research and your arguments can be compromised if it appears that you don’t 
have very much to say. It’s not that you actually write “less” but it can appear to be 
less by breaking it down too much. 
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Need Further Assistance? 
 
Contact: 
 
Henri Mondschein, Ed.D. 
Pearson Library 
California Lutheran University 
60 West Olsen Road 
Thousand Oaks, CA 91360-2787 
 
Tel: 805-493-3012 
FAX: 805-493-3842 
E-mail: mondsche@callutheran.edu 
 
 

 
 


